Account

Enter supplemental login information required for access to resources once a login to an FTP server has been completed. This is
seldom required by current FTP servers.



All Entries

Request that the FTP server include all entries (including dot files) when performing directory listings. This option is usually only
useful when the server is a UNIX system.

This option is off by default.



Anonymous Login

Login to an FTP server with the username anonymous.

Most servers that accept anonymous logins request that you supply your e-mail address as the password. When the Anonymous
Login option is selected for a Quick Connect, or when creating a new session database entry, AbsoluteFTP automatically selects
anonymous as the username and fills in the password field using the password you supplied in your Global Configuration.



Arrange Icons

Sort the items in a folder by Name, Size, Type or Date.

You can choose to enable the Auto Arrange option. With this option enabled the icons in your session window will automatically
adjust their rows and columns as you resize the window. the Auto Arrange option is only available if the icon view has been set to
Large Icons or Small Icons.



Change Directory

Prompts for a directory that becomes the current directory for the selected session. The current directory is displayed in the title
bar of each session.



Close

Closes the connection to the FTP server for the current session and closes the session window.



Command Line Options
For a named session:
AbsoluteFTP.exe /S <session path>
where <session path> is the full path of the session profile in the database.
Example:
AbsoluteFTP.exe /S /Personal/ftp.vandyke.com
Use quotes on the command line if the path contains spaces:

AbsoluteFTP.exe /S "/Van Dyke Technologies"

For a host address:
AbsoluteFTP.exe <hostname or IP>

For a URL:
AbsoluteFTP.exe <FTP URL>

where <FTP URL> is of the following form:

ftp://[<user>[:<password>]@]<host address>[:<port>][<path>]



Connect

The Connect dialog allows you to manipulate your session database and make connections to FTP sites.
The Folders pane displays a tree of folders that you can browse to view your organized FTP sessions.

L] If a folder contains sub folders, a (+) shows to the left of the folder icon. Clicking the (+) or double-clicking the folder will
expand to show the sub folders.

L] Click the (-) next to an expanded folder, or double-click the folder icon to collapse the expanded sub folders.

The following commands are available to manipulate the session folder hierarchy:

New Folder
Rename Folder

Delete Folder
The Sessions pane displays the list of session names in the currently selected folder.
L] Click on a session name to select it and display its description in the Details box.

L] Select a session name and click on Connect or double-click on a session name to start an FTP session.

The following commands are available to create, edit, copy and delete sessions:

New Session
Edit Session
Copy Session

Delete Session

Tips

The New Session button can be configured to invoke the Session Configuration dialog directly rather than the New Session
Wizard. Change this option in the Advanced global configuration.

Click in the checkbox at the bottom left corner of the dialog to choose whether to display the connect dialog when you start
AbsoluteFTP. This feature is enabled by default.

This toolbar button invokes the connect dialog.



Connecting to a Remote FTP Server

There are two methods for connecting to an FTP server:

Method 1: set up a temporary connection using Quick Connect.

[ Choose the 'Quick Connect..." item from the File menu.
L] Enter the server address (e.g. ftp.microsoft.com or 198.105.232.1) in the 'Hostname' field.
L] If the '"Anonymous login' checkbox is checked, you will need to enter your e-mail address as the password in the

'Password' field. This gives you permissions on some servers to download public domain files, but you will probably not be able to
upload files to the FTP server.

Another option here is to uncheck the ‘Anonymous login' checkbox, and enter a valid account name (or login ID) for the server to
which you are connecting in the '‘User name' field. You will need to enter the password for the account in the '‘Password' field.

. Click the 'OK' button.

Method 2: set up a permanent, reusable entry in the session database.

L] Choose 'Connect' from the File menu to bring up the "Connect" window.

u Click the 'New Session' button.

L] Enter the FTP server's address (e.g. ftp.microsoft.com or 198.105.232.1).

. Click the 'Next' button.

L] If the '"Anonymous login' checkbox is checked, you will need to enter your e-mail address as the password in the

'Password' field. This gives you permissions on some servers to download public domain files, but you will probably not be able to
upload files to the FTP server.

Another option here is to uncheck the ‘Anonymous login' checkbox, and enter a valid account name (or login ID) for the server to
which you are connecting in the '‘User name' field. You will need to enter the password for the account in the '‘Password' field.

. Click the 'Next' button.

L] Click the 'Next' button to bypass the initial directory page.

L] Click the 'Finish' button to accept the default session name.

L] Select the new entry just created. Note that this entry is saved in the AbsoluteFTP database and can be reused by

bringing up the "Connect" window (see step 1).

L] Click the 'Connect' button.

After you initiate a connection using one of the above methods, a session window should open and list the files for the account
used.



Copy Path

Copy the path of the selected file or folder to the Clipboard.



Create a copy of the selected session.



Copy URL

Copy the URL of the selected file or folder to the Clipboard.



Copy and Paste

Copy selected files and folders from one folder to another using the keyboard.
Files and folders may be copied between folders within the local machine window, between a folder in a remote session window

and a folder in the local window, as well as between two remote session windows. When a remote session window is part of a
Copy/Paste operation, the Paste initiates the file transfer.

1. Inalocal folder or remote session window folder, click on the file or folder to be copied.
2. Select Copy from the Edit menu
3. Open the folder where you want to put the copy.

4. Select Paste from the Edit menu.
Note, AbsoluteFTP does not support copy/paste of files with other applications.
Tips
L] To select more than one file or folder to copy, hold down the CTRL key, and click each of the items.

L] The Copy and Paste commands are also available in the right mouse button menu.

E=
This toolbar button invokes the Copy command.

This toolbar button invokes the Paste command.



Delete

Deletes the currently selected files or folders.

Tip

This toolbar button invokes the Delete command.



Prompts for the name of the session folder to be deleted. Any sessions or sub folders below it will also be deleted.



Delete the selected session from the session database.



Disconnect

Closes the connection to the FTP server in the current session.

A disconnected session window remains open. The connection to the server can be reestablished with the Reconnect menu item.
Actions like Refresh, opening a directory, or transferring a file will also cause a disconnected session to reconnect.

Tip

This toolbar button invokes the Disconnect command.



Download

Download the selected files and directories. This command will initiate a transfer from the FTP server to the local directory

specified in the default download directory field of the Session Configuration. If the download directory for the session is blank,
then the default download directory setting under the Global Configuration will be used. If both download directory settings are

blank, you will be prompted for the local directory.



Drag and Drop
Copy selected files and folders from one folder to another using the mouse.

1. Click the icon of a file or folder to be copied and hold the mouse button down (normally the left button).

2. Drag the file icon to the destination folder and release the mouse button.

Files and folders can be dragged and dropped (i.e. copied) between folders within the local machine window, between a folder in
a remote session window and a folder in the local window, as well as between the folders of two remote session windows.
Dragging and dropping within a remote session window, however, is not currently supported. If a remote session window is either
the target or source of drag/drop operation, then dropping the file initiates the file transfer.

Note: AbsoluteFTP does not currently support drag & drop of files with other applications.
Tip

L] To select more than one file or folder to drag, hold down the CTRL key, and then click the items you want to copy. Then
drag the selected items as described above.



Renames the selected folder.



Exit

Close all connections and exit the program.



File Transfer Types

Select the appropriate type of file transfer for a given file type:

L] ASCII - Select this mode to transfer text files.
L] Binary - Select this mode to transfer program files, or other non-text files such as ZIP files.
L] Prompt for type - Select this option if you want to be prompted for the transfer type each time a file of the selected type is

downloaded.



Global Configuration, Advanced

Send and receive buffers

By default the system default buffer sizes are used. It is highly recommended that you use the system default buffer sizes.

Cache

Choose the directory where AbsoluteFTP will place its temporary files.

Options

L] New Session uses wizard - Enabling this option causes the New Session button in the Connect dialog to invoke the
New Session Wizard. Disabling this option causes this button to invoke the Session Configuration dialog instead. This option is
enabled by default.

L] Log messages during transfer - Enabling this option causes extra information about file transfers to be sent to the log
window. This option is disabled by default.

L] Move deleted local files to the Recycle Bin - This option is enabled by default. Disabling this option causes deleted
local files to be deleted from the file system.

L] Keep connections alive - This option is off by default. Enabling this option causes AbsoluteFTP to send FTP NOOP
commands to the FTP server whenever 1 minute or more has passed without sending a normal file operation command. This will
usually keep the FTP server from detecting that the connection is idle and, consequently, disconnecting the session.

It is not recommended that you leave this feature enabled.

L] Use outgoing data connections (PASV) - This option is on by default. This is used as the default setting for the
identical Session Configuration option.

L] Disable direct server-to-server transfers - This option is unchecked by default. Checking this option will force all
server-to-server transfers to be handled by establishing indirect data connections through the local host. This option is sometimes
needed where a server behaves poorly after receiving a request to establish a server-to-server connection.



Global Configuration, File Types

Configure the registered file types and their associated actions for remote sessions.

File types can be registered with AbsoluteFTP so that specific actions are taken when files are opened in a remote session. For
example, you can configure AbsoluteFTP to automatically download, then open remote Text Documents with Notepad when you
double-click them in a remote session. The initial file types used by AbsoluteFTP are imported from the settings used by Explorer
when AbsoluteFTP is installed. You may add, edit or remove any of the registered file types.

Note, the actions and applications for the registered file types described here apply only to files opened in remote session
windows. Each file type also includes information that applies only when opening a remote file, such as transfer type and save-to-
disk options. The file types used when opening files in AbsoluteFTP's local window are the same file types used by Windows
Explorer. (Refer to File Types in Windows Explorer Help for more information).

Click the Reset All button to cause all of the file types known by Windows Explorer to be reloaded into AbsoluteFTP.
Enter the following information when editing or registering a new file type:

1. Choose a Default icon to display for the file (recommended).

2. Enter a short text Description of the file type (required).

3. Choose a transfer type.

4. Open with: choose the program that is used to open this file type (recommended).

5.  Remote open: choose the action to be taken when files of the registered type are opened on a remote host. There are three
choices:.

Prompt for open action

Open

Save to disk

6. Associated extensions: Use the Add and Remove buttons to choose filename extensions for the file type (recommended).



Global Configuration, Firewall

AbsoluteFTP can work with a variety of Internet firewall servers. If your FTP connections to Internet sites require the use of a
firewall, then select the appropriate type of firewall (described below) from the dropdown list. In addition to specifying a firewall
type, you may also create a list of domains whose connections are excluded from connecting through the firewall.

The supported firewall types are as follows:
None

Choose this option if you are connected directly to the Internet without a firewall. You may also need to choose this option if
you are behind a router-based firewall, which normally are transparent to the user. If you are behind a router-based firewall,

you need to enable passive data connections. in the session configuration.

SOCKS Version 4,
SOCKS Version 5 (no authentication)

If your firewall server is running either SOCKS version 4 or SOCKS version 5, then select one of these types for the Type
field. Enter the hostname or IP address of your SOCKS firewall server in the "Hostname or IP" field, and enter the SOCKS
firewall port number in the "Port" field. The conventional port number for SOCKS is 1080. Note, the current support for
SOCKS Version 5 does not include authentication or encryption.

OPEN host

Select this type if the your firewall server requires the OPEN command. This type may be selected for the CSM proxy
server. Also, enter the hostname and port of the firewall server in the appropriate fields.

USER user@host:port

Select this type if your server is running the WinGate proxy server. Enter the hostname or IP address and port of the firewall
server in the appropriate fields. This type may also be selected for use with the CSM proxy server.

This type should also be used for the WinProxy proxy server. For this particular proxy server you may also need to have
the Use outgoing data connections (PASV) option unchecked on the Advanced tab.

USER user@host port,
USER user@host port (with login)

Select these types if your server is running the TIS® Internet Firewall Toolkit. Choose the first form if the firewall server
does not require authentication. If your firewall server requires authentication, choose the second form. If you choose the
second form, you should enter the username and password that is required by the firewall server to authenticate your
connection. Also, enter the hostname or IP address and port of the firewall server in the appropriate fields.

Domain exclusion
Excludes specific connections from passing through the firewall.

If AbsoluteFTP is configured to use a firewall, it may still be desired to exclude certain connections from being made through the
firewall. A typical example of this would be an organization that operates a network that is protected from the Internet by a firewall.
Connections to FTP servers within the organization's internal network could be made directly and should not pass through the
firewall, while connections to FTP servers on the Internet must all pass through the firewall. You can exclude the internal FTP
servers by adding them to the exclusion list.

Entries in the domain exclusion list may be either hostnames or IP addresses. A leading or trailing asterisk can be used as a

wildcard character to select groups of machines. For example, the following example of a leading asterisk would exclude
connections to all machines in the domain "yourdomain.com" from connecting through the firewall:

*.yourdomain.com

This example of a trailing asterisk prevents connections to all machines within a particular network from passing through the
firewall:



192.168.0.*

Also, a complete hostname of an FTP server or its IP address can also be used to exclude one specific machine from using the
firewall:

192.168.0.134
ftp.yourdomain.com

Click the Add, Edit and Remove buttons to enter, change and delete entries from the domain exclusion list.



Global Configuration, General

The following options control attributes of transfers and FTP connections.
Transfer options

Choose the default file transfer type for undefined file types.

Choose the default overwrite action when files in a target directory already exist. the choices are:

L] Confirm overwrite - presents a dialog confirming whether or not to overwrite files. The confirmation dialog allows you to
confirm overwrites individually, or to choose the action for all files in the transfer with "Yes to All" or "No to All".
L] Always overwrite - always overwrites existing files in the destination directory.
L] Never overwrite - never overwrites existing files in the destination directory.
L] Overwrite if older - overwrite existing files whose timestamp is older than the source file.
Preferences

Select whether or not to be prompted to resume interrupted transfers when starting a session. This option is enabled by
default.

Choose if you want to be prompted about closing connections when you close session windows. This option is enabled by
default.

Choose whether or not to close session windows when a session is disconnected. This option is disabled by default.

Choose if you want to restore the last remote directory that was visited when starting a session. This option is disabled by
default.

Enter the anonymous password ( usually an e-mail address ) you want to use as the default when you are creating anonymous
login sessions. Note, if you do not fill in this field, then AbsoluteFTP will attempt to fill in anonymous password fields with a
password of the form: username@.

Enter the path of a local directory that is to be used as the destination folder when the Download command is used and the
download directory in the Session Configuration is left blank.

Busy site retry options
Choose the maximum number of login retry attempts that will be performed after a failed login.

Choose the number of seconds to delay between retry attempts.



Global Configuration, View

The following options control attributes of the local window or session windows.

General

L] Display the full path in title bar - Select this option to display the full pathname of the current directory in the title bar of
both the local window and session windows. If this option is disabled, only the directory name is displayed in the title bar. This option
is disabled by default.

L] Show file attributes in Details view - Select this option to include an Attributes column in windows that use the Details
icon view. In the local window this column will display Windows file attributes. In remote session windows this column displays
UNIX-style permissions, owner and group ownership of files. This information is usually only available on UNIX-based FTP servers.

Local Window

L] Display filenames using Explorer attributes - Windows Explorer displays filenames in lowercase with the first character
in uppercase regardless of the actual case of the filename. For example, AUTOEXEC.BAT is displayed as Autoexec.bat. Selecting
this option causes filenames to be displayed using these same rules. Disabling this option displays filenames using their actual
case. This option affects the local window only and is disabled by default.

L] Do not show hidden or system files - This option affects the local window only and is disabled by default.

L] Initial Directory - Enter the path of a local directory that the local window should display on startup.

Remote Window

L] Do not show dot files - Enabling this option prevents filenames beginning with a '." in remote directories from displaying.
This option may also be set from the View menu. By default, it is enabled.

L] Set the maximum number of lines that each log window can display.



Hide Dot Files

Prevent filenames beginning with a '." in remote directories from being displayed.

This option corresponds to the Do not show dot files option in the Global Configuration.



Hostname

Most FTP servers have a hostname that you can use to connect to them, like ftp.microsoft.com, ftp.vandyke.com, etc. A valid
hostname will also correspond with an |P_address. When specifying a host address for a session you may enter either a

hostname or an |P_address.



IP Address

Every site that is reachable on the Internet must have a valid IP, or Internet Protocol, address. An IP address should be entered
as 4 numbers separated by period (.) characters, for example: 198.105.232.1



Icon View Options

Select the size and layout of the icons shown in the right-hand pane of a window.

The following choices are available from the View menu:: Large Icons, Small Icons, List, or Details.
Tip

The icon view options may also be selected from the toolbar via the following icons:

Icon View Type

Large icons
Small icons
se List

[ Details



Initial Directory

Specify the initial directory for an FTP session.

If the initial directory has been specified for a session, then that directory will be made the current directory upon connection to
the remote host. If the initial directory is not set, then the default or home directory for the username on the remote system will be

the initial directory.



Invert Selection

Toggle the selected or unselected state of all items in the current folder.



License Registration

Upon receipt of payment, we will send you one license key for each copy of AbsoluteFTP paid for. The new license key(s) will
have no expiration. The license key(s) will be sent to you via e-mail or postal mail. Note, no disk will be sent. All updates to
the software will be made available via anonymous FTP.

A single license for AbsoluteFTP is $29.95 (U.S.). After January 1, 1999, the price of a single license for AbsoluteFTP will be
$34.95 (U.S.).

Four payment methods are available:
Order online:

To order online via a secure or non-secure web server:

http:/lwww.vandyke.com/order/index.html
Ordering by check:

To order by check, send the order form (click here) and a check to:

Van Dyke Technologies

P.O. Box 37457

Albuquerque, NM 87176

USA
Payments must be in U.S. dollars drawn on a U.S. bank.
CompusServe Registration:

If you have a CompuServe account, you can have the registration fee added to your CompuServe bill. Just type GO SWREG.
Specify registration 1D 16157.

Ordering by Credit Card:

You can order with MC, Visa, Amex, or Discover from Public (software) Library:

Phone: 800-2424-PsL ext. 15414
713-524-6394 ext. 15414
FAX: 713-524-6398

Internet: 15414@pslweb.com
U.S. Mail: PsL, P.O. Box 35705, Houston, TX 77235-5705

PsL's product number for AbsoluteFTP is 15414.

PsL is open from 8:30am-5pm CST Monday-Friday (except holidays).

The above numbers are for credit card orders only. The authors of AbsoluteFTP cannot be reached at these numbers.
Any questions about the status of the shipment of the order, refunds, registration options, product details, technical support,
volume discounts, dealer pricing, site licenses, non-credit card orders, etc., must be directed to Van Dyke Technologies, P.O. Box
37457, Albuquerque, NM 87176, USA or sales@vandyke.com.

PsL will notify us either the day you place your order or the following business day. We will send you the license key(s) directly.

After calling PsL, send e-mail to sales@vandyke.com if you want your key e-mailed to you.



Line up Icons

Line up icons that are out of alignment in a folder.

This option is not available if you have selected List or Details for your Icon View options.



Log Window

Each session window displays a log of the FTP commands sent to the FTP server and the responses that are received. You can
adjust the number of visible lines for the log window by dragging the horizontal splitter bar of the session window upward or
downward.

Adjusting the log window buffer size

By default, the log window holds 500 lines. You can adjust the size of the log window buffer in the Global Configuration dialog.

Copying the log window text to the Clipboard

Copy the log window contents to the Clipboard by right-clicking in the log window and select "Copy" from the context menu.

Clearing the log window

Clear the log window contents by right-clicking in the log window and select "Clear" from the context menu.



Long Format

Request that the FTP server include all available columns of informational output when performing directory listings. This option
is usually only useful when the server is a UNIX system.

This option is off by default.



Manual Download

Download a specified file or folder. This command will initiate a transfer from the FTP server to a local directory. The default
local directory is set to the download directory specified in the download directory settings of the Session Configuration or

Global Configuration. The path of the file or folder to download is entered manually. This feature is often used to download a
file that is intentionally hidden by the server but can still be retrieved if the user knows the exact name and location of the file.



Navigating a Session

Each FTP session is represented by its own session window

L] The left pane of the session window shows the hierarchy of the folders on the remote host.

L] Click a folder in the left pane to display its sub folders and files in the right pane ( If the folder contains any sub folders
then a (+) will also appear to the left of the folder icon ).

M A folder-open icon
E indicates which folder is currently selected in the left pane. The complete contents of the currently selected folder are shown in
the right pane.

L] Double-click a folder icon in the left pane ( or click the +/-) to expand and collapse the tree of sub folders in the left pane.

L] A log window of FTP commands for a session can be viewed by dragging the lower border of the session window upward.



New Folder

Prompts for a directory name and creates a new directory within the current directory.



Prompts for the name of a new session folder and creates it within the currently selected folder.



New Session Wizard

The New Session Wizard guides you through the steps of adding a new session to your session database. The wizard prompts
you for the following information that it stores in your new session:

1. Hostname/IP Address

2. Optionally, select non-default Port to change the port number .

3. Username/password

4. [Initial Directory

5. Asession name that will be used to identify the session in the session database.

6. Adescription for the session that will be shown in the details box of the Connect dialog.



Open

Opens the currently selected file or folder.

You can also double-click a file to open it or select it and choose Open from the right mouse button menu.

AbsoluteFTP can be configured to automatically download and open a file on a remote site with an associated application. The
configuration options are available in the Global File Types dialog.



Open URL

The Open URL dialog allows you to connect to a remote host using its Uniform Resource Locator (URL). This dialog can be
used to connect to an FTP server and list the directory or download a file that is specified by a URL obtained from a Web browser
or an e-mail message.

In the Open URL dialog:
1. Enter the URL (e.g. ftp://ftp.vandyke.com/pub/Absolute FTP)

2. Click OK.



Open With

Brings up a dialog that lets you choose an application to use for opening the selected file.

"Open With" is also available from the context menu.



Order Form

The pricing below is valid through December 31, 1998. After this date, check http:/lwww.vandyke.com for current pricing.
To print the order form, click on Print Topic in the File menu.

Send this order form and a check to:

Van Dyke Technologies
P.O. Box 37457
Albuguerque, NM 87176
USA

Payments must be in U.S. dollars drawn on a U.S. bank.

AbsoluteFTP Pricing:

Single Computer License $29.95 each =
2 to 9 Computers:  Computer Licenses @ $27.50 each =
10 to 24 Computers:  Computer Licenses @ $25.00 each =
25 to 49 Computers:  Computer Licenses @ $20.00 each =
50 to 99 Computers:  Computer Licenses @ $17.50 each =
100 to 199 Computers:  Computer Licenses @ $15.00 each =
Unlimited Computers (Single Site): $2500.00 =
New Mexico Residents only: add 5.8125% sales tax +

Total Payment

—-—— Please Print ---

Name : Date:

Company:

Address:

City, State, Zip:

Country:

E-Mail Address:

Would you like to receive update announcements via e-mail?

How did you hear about AbsoluteFTP:

Comments:




Other Support Issues

If you think you've found a bug or a problem with AbsoluteFTP, please refer to the section on reporting problems.

If you have a general question about AbsoluteFTP, send e-mail to:

AbsoluteFTP-questions@vandyke.com

If you would like to receive e-mail notification when new releases of AbsoluteFTP are announced, send e-mail to the following
address with the word "subscribe" on the subject line.

AbsoluteFTP-announce-request@vandyke.com

If there is a feature that you would like to see added to AbsoluteFTP, send e-mail describing the feature to:

AbsoluteFTP-features@vandyke.com



PASV

Force the FTP server into passive mode when establishing data connections. This will cause AbsoluteFTP to actively create any
data connections rather than passively listen for data connections from the server. This option is sometimes needed where the
client machine resides on a network whose firewall will not allow incoming connections from external FTP servers.

The options for using this command can be found in both the Session Configuration and the Global Configuration.



Port

The port number to connect to on the FTP server. The default port value for FTP is 21. You should not need to change this value
for most FTP sessions, but some FTP servers may require that you connect to them using a non-default port number.



Properties

Invoke the Properties dialog on a selected file. The Properties command can only be invoked on remote files and directories.

The properties dialog displays information such as the name, type, location, size, creation/modification date and owner for the
selected file. Additionally, the attributes section of the dialog also allows you to view and change the UNIX-style permissions on

files and directories.

Note: Viewing and changing the attributes of remote files and directories is not supported by all FTP servers. This feature is
currently only available on UNIX-based FTP servers.

Tip

This toolbar button invokes the Properties command.




Quick Connect

The Quick Connect dialog allows you to connect to a remote host that is not present in the session database.

In the Quick Connect dialog:

1. Enter the hostname or IP address of the remote FTP server for the session. (This is the only required field. You can click
OK to make the connection).

2. Change the port number (optional).
3. Enter a username and password for the remote session, or accept the default Anonymous Login setting.

Note: if either the username or password fields are left blank, then you will be prompted for that information when the
connection is made.

4.  Enter an initial directory (optional).

5. Click OK.

Tip

This toolbar button invokes the quick connect dialog.



Quote Command

The Quote Command feature is used to send a command directly to the FTP server. Any messages returned by the FTP server in
response to the command are displayed both in the log window and in a separate, pop-up window.



Reconnect

Reestablishes the connection to the FTP server for the current session and login using the username and password for that
session.

The connection to an FTP server may be dropped as the result of a timeout after a period of inactivity, or because the user has
executed the Disconnect command. Invoking the Refresh command, opening a directory or transferring a file within a session that
is disconnected will cause the session to automatically reconnect. You may, however, manually reconnect to the FTP server using

this menu item.

Tip

This toolbar button invokes the Reconnect command.



Refresh

Updates the displayed information for the selected session by retrieving a new listing.

The folders and files present on a remote FTP server may change at any time. Refresh obtains a new listing for the current folder
from the server.

Tip

]
This toolbar button invokes the Refresh command.



Automatically open the file (after downloading) using the associated program when remote files of this type are opened.



Rename

Renames the currently selected files and folders.

You may rename multiple files in the local window using MS-DOS wildcards.



Reporting Problems
You may report problems or bugs to us through our on-line problem-report form on the AbsoluteFTP support Web page:

http:/lwww.vandyke.com/support/AbsoluteFTP/

You can also report problems by sending e-mail to us at the following address:
AbsoluteFTP-bugs@vandyke.com
When reporting bugs through e-mail, please try to provide the following information:

The steps needed to reproduce the bug.

A description of the problem in as much detail as possible.

The version of AbsoluteFTP (as shown in the About dialog box).
TCP/IP package and version.

The operating system and version (and Service Pack #, if any)



Resolve Symbolic Links

Request that the FTP server resolve symbolic links automatically when performing directory listings. This option is usually only
useful when the server is a UNIX system.

This option is on by default. If the server resolves symbolic links, then symbolic links to files and folders will be completely
transparent and look no different than regular files and folders.

If this feature is disabled, symbolic links in a folder will initially be displayed with this icon:

&

Clicking on a symbolic link icon will resolve the link to the actual file or directory to which the link points.

It is recommended that this feature be left enabled.



Resume

Resumes an interrupted file download for the current session. Resume only keeps track of the most recently interrupted transfer
for each session.

An interrupted transfer can be resumed at any time in a session by selecting Resume from the File menu. Additionally, if a
transfer has been interrupted for any session in the session database, then the next time that session is started a dialog will
prompt with the following choices:

Resume the interrupted download immediately
Delay resuming the download until later
Forget about the interrupted download

To turn off this prompting, uncheck the "Prompt to resume interrupted transfers” option in the General Global Configuration dialog.

Interrupted file transfers may also be resumed manually or on-demand in addition to the above mechanism. This is
accomplished by simply transferring the file in the usual way (i.e. drag & drop, cut/paste, download, etc.). If the file already exists
in the destination folder, AbsoluteFTP will compare the size of the source file against the size of the destination file. If the size of
the destination file is less than the size of the source, AbsoluteFTP will ask you if you want to overwrite the destination file,
resume the transfer, or skip the file transfer.



Automatically invoke a dialog that prompts for the filename and the location to save the remote file when it is opened.



Select All

Select all of the items in the current folder.



Session Configuration, Advanced

Specify the parameters for an existing FTP session in the session database.

1. Setthe server host type. By default the type of FTP server will be automatically detected when connecting. Or, the server
type can be set to a specific supported type.

2. Set the Resolve symbolic links option to cause AbsoluteFTP to include the '-L' flag when listing files and directories.

3. Set the All entries option to cause AbsoluteFTP to include the '-a' flag when listing files and directories.

4. Set the Long format option to cause AbsoluteFTP to include the '-I' flag when listing files and directories.

5. Setthe Use outgoing data connections (PASY) checkbox to force all data connections to be originated by AbsoluteFTP
(using the FTP PASV command). This setting is often needed where a firewall will not allow incoming connections from
external FTP servers. When this checkbox is unchecked, AbsoluteFTP will have the FTP server create an incoming data

connection instead (using the FTP PORT command).

This checkbox can also be set to a third, indeterminate state. When the checkbox is in this state, it appears grayed out and
will cause AbsoluteFTP to use the identical, Global Configuration option.

6. Choose the case-conversion rules for the names of uploaded files: Preserve case, Uppercase or Lowercase.



Session Configuration, General

Specify the parameters for an existing FTP session in the session database.

1. Enter a Name for the session to uniquely identify the session in the database. This name will show up in the Sites pane of
the Connect dialog.

2. Enter an optional Description for the session. Later, when you click on the name of a session in the Connect dialog, this
description will appear in the Details box of the dialog (optional).

3. Enter the path of a local directory that the local window should display whenever a connection for this session is established
(optional).

4. Enter the path of a local directory that is to be used as the destination folder when the Download command is used. If the
field is left blank, the download directory in the Global Configuration will be used (optional).



Session Configuration, Site

Specify the FTP server parameters for an existing FTP session in the session database.

1. Enter the hosthame or IP address to which you want to connect.
2. Select non-default Port to change the port number (optional).

3. Enter an initial directory for the remote session (optional).

4. Select Anonymous Login or enter your username and password for the remote system. Note: if either the username or
password fields are left blank, then you will be prompted for that information when the connection is made.

5. Enter an account name. This parameter is usually not needed (optional).



Session Database Location

Choose the directory where the session database files (AbsoluteFTP.dat, AbsoluteFTP.idx) will be stored.

This command is not available when sessions are active.



Session History

Connect to a session from the list of most-recently-used sessions.



Session Window Options

Choose the mode to display session windows.

Cascade

Resize and display all open session windows to be slightly overlapped and descending from the upper-left corner of the main
window.

Tile Horizontally

Resize and display all open session windows to be the width of the main window, equal-sized and vertically spaced to fill the
entire main window.

Tile Vertically

Resize and display all open session windows to be the height of the main window, equal-sized and horizontally spaced to fill
the entire main window.



Set Initial Directory

Copy the path of the selected folder into the appropriate Initial directory configuration field.

When this option is used in a session window, the Initial directory field of the Session Configuration will be set to the path of the
currently-selected folder.

When this option is used in the local window, the Initial directory field of the Global Configuration will be set to the path of the
currently-selected folder.



Status Bar

Shows or hides the status bar for the selected session window.

When enabled, the status bar appears at the bottom of a session window. Informational text such as connection status, or the
number of folder entries, is displayed in the status bar.

The status bar is enabled by default.



Stop

Interrupts the current FTP operation in the active remote session window.

Tip

@ This toolbar button invokes the Stop command.



System Requirements

Minimum of a 486-based machine with 16 megabytes of RAM.
Windows NT® 4.0, Windows® 95, or Windows® 98

winsock.dll (compliant with version 1.1 of the WinSock standard).
32-bit TCP/IP stack.



Toolbar

Show or hide the toolbar.

When enabled, the toolbar appears below AbsoluteFTP's menu bar. Move the mouse cursor over a toolbar button to view its
associated action. The toolbar is enabled by default.

Below is a list of the actions associated with the icons.

Icon Action

Displays the Quick Connect dialog
Displays the Connect dialog

Reconnect the selected session window
Disconnect the selected session window
Copy the selected item(s)

Paste the selected item(s)

Refresh the current view

Stop the current FTP operation
Delete the selected item(s)
Invoke the Properties dialog on the selected item

Move the view up one level from the current folder
Display files and folders as large icons

Display files and folders as small icons

Display files and folders as a list

Display files and folders in detail

e ECEC T E



Transferring Files

Transferring files to or from FTP sites is easily accomplished by any of the following operations:

L] Open a remote file - Opening a file (either by double-clicking on it or by using the Open menu command) in a remote
session window will initiate a download of the file. By default, you will be prompted whether you want to open the file in its
associated application or save it to disk. You can configure AbsoluteFTP to automatically save the file to disk or open it by

specifying the open action when editing or registering the file type.

L] You may also choose the menu Download command to initiate a transfer of the selected files and folders from a remote
session window to a local download directory specified in the Session or Global Configuration.

L] You may also initiate a transfer using the Copy and Paste and Drag and Drop methods (described below)
The steps to upload a local file to a remote FTP server are as follows:
L] Connect to a remote FTP server.

L] Optionally, choose the 'Tile Horizontally' item from the 'Window' menu to size the local and remote windows and place
them side by side.

L] In the local window, browse to and open the folder/directory that contains the files you want to upload.
L] In the remote/session window, browse to and open the folder/directory to which you want to upload the local files.
L] At this point, you can initiate the file transfer using either the "drag & drop" or "cut & paste" method.

a) Drag & drop: using the left mouse button, click on the icon for file you want to transfer and continue to hold down the left mouse
button. While still holding down the left mouse button, move the mouse cursor so that it is positioned over the right-hand pane
(where the folder contents are shown) of the remote window. Release the left mouse button to "drop" the file on the remote
window.

or

b) Cut & paste: select/highlight the files that you want to transfer. Choose the ‘Copy' item from the 'Edit' menu. Then, select the
folder/directory in the remote window to which you want to upload the files. Then, choose the 'Paste’ item from the 'Edit' menu.

A separate window should appear that shows the progress of the transfer.

When the transfer completes, the target window will automatically refresh and the transferred files should be visible in the right-
hand pane of that window.

The copy/paste and drag & drop methods may also be used to initiate file and folder transfers directly between remote FTP
servers.



Invoke a dialog that lets you choose whether to automatically open the file (after downloading) with an associated application or
save it to disk each time a remote file of this type is opened.



Welcome

This file documents AbsoluteFTP version 1.5. If you do not find the information you need here, please e-mail any questions you
have to the following address:

AbsoluteFTP-questions@vandyke.com.
We will try to respond within 1-2 business days.

AbsoluteFTP is a trademark of Van Dyke Technologies, Inc.



What is AbsoluteFTP?

AbsoluteFTP is a 32-bit WinSock application that uses the File Transfer Protocol (FTP) to transfer files over the Internet and
intranets. AbsoluteFTP has a rich set of features, including a familiar Windows Explorer interface, drag and drop file transfers,
resumable interrupted transfers, customizable file types, and multiple simultaneous connections and transfers. Browsing your
favorite FTP sites to download new applications, images, and other files is now easier than ever with AbsoluteFTP.

AbsoluteFTP includes a 30-day, try-before-you-buy, fully-functional evaluation license.

AbsoluteFTP is ideal for browsing your favorite FTP sites. Many software and hardware companies use FTP sites
(ftp.vandyke.com, ftp.netscape.com, ftp.microsoft.com) to distribute their software. There are also many FTP sites which
specialize in distributing games, images and applications for all types of operating systems.

AbsoluteFTP has the following set of features:

Familiar Windows Explorer user interface for the local and remote site
Upload and download multiple files from multiple sites concurrently
Direct server-to-server transfers

Resume interrupted/incomplete file transfers

URL support

SOCKS version 4 and SOCKS version 5 firewall support

TIS®, WinGate and CSM proxy support

Hierarchical session database for managing personal sites

Named sessions allow saving of individual preferences for each site
Automated download action by file type

Manual download for downloading hidden files

Drag and drop (and copy and paste) file transfers

Network Neighborhood support

Ability to change file attributes

Easy setup/install

Automatic resolution of symbolic links (option)

Auto hide of dot files (option)

Quote command

Uppercase/lowercase filename conversion on upload

Quick connect dialog for easy connections

Common features accessible via the right mouse button menu
Easy access to AbsoluteFTP features through graphical toolbar
Caching of remote host directory listings



Window Menu List

The titles of each of the local and remote windows are displayed in a list in the Window menu. The currently selected window is
checked. Click on a window title to bring it to the top and select it.






